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はじめに（本資料についての注意事項）

• X線吸収微細構造(XAFS)の中でも、広域XAFS(EXAFS)の解析方法を中心に説明して
います。

• Bruce Ravel 博士により制作され、ネット上でフリーで提供されている XAFS の 解析
ソフトウェアの Demeter (Athena と Artemis を含むパッケージ)を用いています。

• 本資料内の Demeter は 64bitの Ver. 0.9.26 です。なお、Demeter のバージョンは、
随時、更新される可能性があります。

• Demeter のインストール方法の詳細や注意点は、下記URLの資料をご覧ください。
https://www.aichisr.jp/content/files/BL5S1/Demeter_install_data_reading.pdf

• 説明文中の p.2 などの英数字は、各スライドの右上のページ番号を表しています。
また、p.3 については、p.3(D)のように 各参考資料に対応する英字を併記しています。

• 本資料内の EXAFS解析の手順や考え方が、他のXAFS経験者と異なる可能性は大いに
ありますので、解析の一例として捉えてください。

• Athena と Artemis の ”基本的” な使い方を述べています。それらの使い方 や XAFSの
解析内容について、疑問が生じたときや更に詳しい内容を知りたいときは、
「参考資料 (p.3)」の各資料をぜひ参照してください。
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参考資料【2023年10月17日 最終閲覧】

A) Athena, Artemis の本家マニュアル 英語 (作成：Bruce Ravel 博士)
http://bruceravel.github.io/demeter/documents/Athena/index.html

http://bruceravel.github.io/demeter/documents/Artemis/index.html

B) Athena の本家マニュアルの日本語訳 (作成：近畿大学 朝倉博行先生)
https://www.apch.kindai.ac.jp/laboratory/asakura/personal/ja/others/aug/index.html

C) Athena, Artemis のチュートリアル (作成：近畿大学 朝倉博行先生)
https://www.apch.kindai.ac.jp/laboratory/asakura/personal/ja/others/dtj/

D) Athena のインストール方法およびデータの開き方 (p.2のURLと同じ)

(作成：AichiSR BL5S1, BL11S2 担当者)
https://www.aichisr.jp/content/files/BL5S1/Demeter_install_data_reading.pdf

E) Athena の便利な使い方 (作成：AichiSR BL5S1 担当者)
https://www.aichisr.jp/content/files/BL5S1/Athena_utilities.pdf

F) X線吸収微細構造 －XAFSの測定と解析－ 日本分光学会 測定法シリーズ 26 

(宇田川康夫[編]、学会出版センター)

G) XAFSの基礎と応用 (日本XAFS研究会[編]、講談社)
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配布データ

Athenaでの「EXAFS解析の基礎的な考え方」で用いるデータ(p.15~)

• CuO-EXAFS.dat

• Cu-foil.dat

• CuO.dat

AthenaとArtemisでの「EXAFS解析の具体例」で用いるデータ(p.33~)

• AuFoil.dat

• Au100.dat

• Au200.dat

• Au300.dat

• Au400.dat
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※ Cu関係の datデータ は AichiSR BL5S1で取得しました。データ形式は 9809フォーマット
 (p.9) です。AichiSR BL6N1, BL11S2 も同データ形式です。

※ Au関係の datデータ は KEKの 仁谷浩明先生からご提供いただきました。SPring-8 

 BL01B1で取得されたデータで、9809フォーマットです。

※全て「透過法」で得られたデータです。

※上記データは、以下のURLの「配布データ (zip形式)」にあります。
 http://titan.nusr.nagoya-u.ac.jp/Tabuchi/BL5S1/doku.php?id=tsukada:text-tsukada



Athena（アテナ）

Artemis（アルテミス）

Hephaestus（ヘパイストス）

• 対象元素の吸収端や蛍光X線の各エネルギーの検索
• 未知の吸収端や蛍光X線のエネルギーに対する元素の検索、等

• 吸収端近傍XAFS (XANES, NEXAFS) スペクトルの各種処理
• Artemisで EXAFSスペクトルを解析するための条件決め
（バックグラウンド処理、EXAFS振動の抽出、等）

Demeterとは…
XAFS解析ソフトウェア Ifeffitを初心者でも扱いやすいように、
Bruce Ravel 博士が GUI のソフトウェアとして開発したもの

• ATOMS を用いた FEFFファイルの作成
• FEFF（多重散乱理論に基づくXAFSの理論計算コード）を
用いた EXAFSスペクトルのフィッティング
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【本資料の一番最後に説明あり】

Demeter とは



Athenaの使い方
～EXAFS解析の前準備～
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・本資料では、以下の OS と Demeter を用いて説明している。
OS :  Windows10（64bit版）
Demeter :  Ver. 0.9.26

・Demeter は以下の URL からフリーでダウンロードできる。
https://bruceravel.github.io/demeter/ (2023年10月17日最終閲覧)

・文字化け対策として、Demeter を 0.9.25以降のバージョンに
更新すること。
各CPU に対応した最新版は以下の通りである(2023年10月17日現在)。

32bit → Ver. 0.9.25 (※)

64bit → Ver. 0.9.26

(※) Ver. 0.9.25（32bit版）は、上記 URL のWebページ
の一番下にある「Earlier packages」から
ダウンロードできる。（p.3(D)参照）

7Demeter のダウンロード 

文字化け



プラグイン(PFBL12C)の有効

① [Main window] を左クリックして [Plugin registry] を選択する
② [PFBL12C :  Photon Factory, SPring-8, SAGA, and Aichi XAS Beamlines] に☑を入れる
③ 左下の [Return to main window] を左クリック、もしくは、左上の [Plugin registry] 

を [Main window] に変更して、メインウィンドウに戻る

①

②

③

③
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プラグインを有効にして、Athenaでデータを読み込めるようにする。



ヘッダ部

データ部

角度
（指示値）

角度 θ
（実測値）

測定
時間

各検出器の信号強度

𝐸 =
12398.52

2𝑑 ∙ sin𝜃

E : 入射X線のエネルギー [eV]

d : 分光結晶の格子面間隔 [Å]

θ : 分光結晶に対する入射光の視射角（分光器の角度）[deg]

d [Å] とθ [deg] から 入射X線のエネルギー E [eV] を算出する。【プラグインの☑が必要】

・分光結晶の種類
・格子面間隔 d

9データ形式（AichiSR 5S1 / 11S2 / 6N1）

9809

フォーマット



[Energy] 

energy_attained に⦿が付いていることを確認する。

[Numerator] (分子)

[Denominator] (分母)

☑の位置はBL毎で異なる
ため、利用したBLで確認
する。

・透過法 → ☑を入れる
・蛍光法, 電子収量法 → ☑を外す

計算式が合っているかを確認する。(i0とi1の前の英字は

ランダムに表示されるため、本図(kjdqz.)と異なっていても問題ない。)

Athenaでのデータ読込画面（5S1 / 11S2 / 6N1）

[Data type]

μ(E)   ：EXAFSも解析可能
xanes：XANES (NEXAFS)

のみの解析可能

透過法で測定する場合、
I0：入射X線の強度
I：透過X線の強度
μ：線吸収係数
t：試料の厚さ

とすると、

と表せるため、 [Natural 

log] に☑を入れる。

（蛍光法と電子収量法の
計算式は p.12参照）

𝜇𝑡 = ln
𝐼0
𝐼
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入射X線の
エネルギー

各検出器の信号強度

AichiSRの BL1N2 と BL7U は回折格子で分光しているビームラインであり、
角度 ではなく 入射X線のエネルギー [eV]がデータ列として保存されている。

→ Athena のプラグイン(PFBL12C) について、
無効・有効のどちらの状態でもデータの読み込みが可能。

11【参考】データ形式（AichiSR 1N2 / 7U）



[Energy] 

1 に ⦿ が付いていることを確認する。

☑を外す

計算式が合っているかを確認する。(数字の前の英字は
ランダムに表示されるため、本図(yezhj.)と異なっていても問題ない。)

[Numerator] (分子) 

[Denominator] (分母)

☑の位置はBL毎で異なる
ため、利用したBLで確認
する。

【参考】Athenaでのデータ読込画面（1N2 / 7U）

蛍光法 と 電子収量法は、

I0：入射X線の強度
I：試料の信号強度
μ：線吸収係数
t：試料の厚さ

とした場合、どちらの
手法も

         (ほぼ比例)

と表せるため [Natural 

log] の☑を外す。
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𝜇𝑡 ∝
𝐼

𝐼0



②

③

④

⑤

①

Main window について (1) 13

① データの情報、
エネルギーシフトの
設定 (エネルギー較正の
ために使用) 

② XANES (NEXAFS) の
規格化条件
→ Eで表示
(EXAFS解析でも重要！)

③ EXAFSのバックグラウ
ンドの引き方
→ E および kで表示

④ EXAFSのフーリエ変換
の範囲と条件
→ kおよび Rで表示

⑤ EXAFSの逆フーリエ変換
の範囲と条件
→ Rおよび qで表示



Main window について (2)

⑥ 開いたデータのリスト

⑦ ⑥で青色反転したデー
タのみをグラフに表示
   ：エネルギー
： EXAFS振動
：フーリエ変換
：逆フーリエ変換
： kとqを同時に表示

⑧ ⑥で☑を入れたデータ
をグラフに表示 (各記号
の意味は➆と同じ)

⑨ フーリエ変換する時の
EXAFS振動の重み付け
（kn χ(k)の n）

⑩ ➆の表示条件
⑪ ⑧の表示条件

⑫ グラフの表示範囲

➆
⑧

⑨

⑩

⑥

⑪

⑫
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Athenaでの

「EXAFS解析の基礎的な考え方」

使用するデータ

• CuO-EXAFS.dat

• Cu-foil.dat

• CuO.dat
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透過法 CuO-EXAFS.dat のデータ読込

• CuO-EXAFS.dat をデスクトップ(もしくは、Cドライブ)に保存する
（2バイト文字を使ったフォルダ内に保存するとデータが開けません！）

• File → Import data → CuO-EXAFS.dat → [開く]

• データを Athena の白枠部分 (p.14 ⑥) にドラッグする

• 下図のように設定した後、左下の [OK] を押す

計算式が合っているかを確認する。

16

[Energy] → energy_attained

       に⦿を入れる
[Numerator] → i0に☑を入れる
[Denominator] → i1に☑を入れる

[Natural log] → ☑を入れる

[Data type] → μ(E)にする 
(xanesを選ぶとEXAFS解析が行えません！
 データ読込後の Data type の変更方法は p.17)

配布した他のデータ(p.4)の設定も同様である



データ読込後の Data type の変更方法

• データ名の上で右クリック

• [Change data type] を左クリック

• 【Athena: Change datatype】で、
「変更したいデータ(Change datatype for…)」
と「タイプ (Change datatype to…)」を選択

• [OK]を押す

17

データを読み込むと表示される画面

データ展開後の画面、Data typeの変更方法



グラフの呼び方や説明文の例

• XAFSスペクトル
• XANESスペクトル, NEXAFSスペクトル

(表示するエネルギー範囲が短いとき)

• EXAFS振動
• EXAFSスペクトル

• 動径構造関数 (XAFS特有の呼び方)

• 動径分布関数 (一般的な呼び方)
• 動径構造関数の 1~2 Å に窓関数をかけて
逆フーリエ変換して得られたEXAFS振動

18

窓関数



Athena/ArtemisによるEXAFS解析の流れ

• EXAFS振動の抽出のために、「吸収端におけるエッジジャンプ μ0(E0)」
と「バックグラウンド (スプライン曲線)」を決定する

• フーリエ変換 ( k → R ) のために、「kの範囲などの条件」を決定する
• 逆フーリエ変換 ( R → q ) のために、「Rの範囲などの条件」を決定する

Artemis

Athena

• 【未知試料】のデータに対して、「標準試料で求めた S0
2」を適用しな

がら、上記の ①～④ のいずれかの方法でフィッティングを行う

• フィッティングの変数( N / E0 / R / σ2 )と グラフ の妥当性を判断する
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• Athena で解析した【標準試料】のデータを読み込む
• Scattering Path (散乱経路) を求めて EXAFS振動のフィッティングを行う
ために、以下のいずれかの方法を用いる

  ① 自分で結晶構造パラメータを入力する方法
  ② CIFファイル (Crystallographic Information File) を用いる方法
  ③ QFS (Quick First Shell fit) を用いる方法（XAFSならではの方法！）
  ④ FEFFファイルを編集する方法（最もXAFSならではの方法！）

• フィッティングの変数( S0
2 / E0 / R / σ2 )と グラフ の妥当性を判断する



Athena/ArtemisによるEXAFS解析の流れ

• EXAFS振動の抽出のために、「吸収端におけるエッジジャンプ μ0(E0)」
と「バックグラウンド (スプライン曲線)」を決定する

• フーリエ変換 ( k → R ) のために、「kの範囲などの条件」を決定する
• 逆フーリエ変換 ( R → q ) のために、「Rの範囲などの条件」を決定する

Artemis

Athena

• 【未知試料】のデータに対して、「標準試料で求めた S0
2」を適用しな

がら、上記の ①～④ のいずれかの方法でフィッティングを行う

• フィッティングの変数( N / E0 / R / σ2 )と グラフ の妥当性を判断する
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• Athena で解析した【標準試料】のデータを読み込む
• Scattering Path (散乱経路) を求めて EXAFS振動のフィッティングを行う
ために、以下のいずれかの方法を用いる

  ① 自分で結晶構造パラメータを入力する方法
  ② CIFファイル (Crystallographic Information File) を用いる方法
  ③ QFS (Quick First Shell fit) を用いる方法（XAFSならではの方法！）
  ④ FEFFファイルを編集する方法（最もXAFSならではの方法！）

• フィッティングの変数( S0
2 / E0 / R / σ2 )と グラフ の妥当性を判断する



AthenaでのEXAFS解析のフロー図 21

「kの範囲などの条件」を決定する

EXAFS振動の抽出 ( )

「吸収端におけるエッジジャンプ μ0(E0)」と
「バックグラウンド (スプライン曲線)」を決定する

「Rの範囲などの条件」を決定する

qの EXAFS振動に対してフィッティングを行う

フーリエ変換    ( )

Athena

Artemis

逆フーリエ変換   ( )



AthenaでのEXAFS解析のフロー図 22

「kの範囲などの条件」を決定する

EXAFS振動の抽出 ( )

「吸収端におけるエッジジャンプ μ0(E0)」と
「バックグラウンド (スプライン曲線)」を決定する

「Rの範囲などの条件」を決定する

qの EXAFS振動に対してフィッティングを行う

フーリエ変換    ( )

Artemis

逆フーリエ変換   ( )

Athena



Athenaでは EXAFS振動 を抽出する式が以下のように表されるため、
を決定する必要がある。(p.3(C))

• E0(吸収端)のエネルギーの小数点以下の値を消す (EXAFS解析で最終的に

得られるE0の値が、この設定値の相対値で示されるため、オススメ。）

• 右下の黄色の枠
Background → ☑を外す
pre-edge line → ☑を入れる
post-edge line →  ☑を入れる

𝜒(𝑘) =
𝜇(𝐸) − 𝜇0(𝐸)

𝜇0(𝐸0)

𝜇0(𝐸)

𝜇0(𝐸0)

：単純な原子のX線吸収スペクトル

：吸収端におけるエッジジャンプ

𝜇(𝐸) ：吸収スペクトル

χ(𝑘) ：EXAFS振動

吸収端でのエッジジャンプ μ0(E0) の決定 (1)

𝜇0(𝐸0)
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𝜇0(𝐸0)

Pre-edge line

Post-edge line



• Normalization order → 3（2次関数 (1は0次関数、2は1次関数)）
• Pre-edge range →   -250 ~ -50（E0からの相対値）
• Normalization range → 50 ~ 1100（E0からの相対値）

• を押してグラフ上を左クリックすると、その位置が設定点になる
（スペクトルの表示範囲が短い場合は、グラフ上部の       を押す、もしくは、
グラフを左クリックした後にキーボードの  A  を押すと、全体が表示される）

• スペクトルの規格化のパラメータが
問題ないことを確認するために、
右下の黄色の枠の
Normalized を左クリック
して☑を入れ、
XAFSスペクトルを
表示する

吸収端でのエッジジャンプ μ0(E0) の決定 (2) 24



続いて、EXAFS振動を抽出するために、バックグラウンドを決定する。

• CuO-EXAFS.dat を左クリックして青色反転させる

•  を左クリックする

• 右下の黄色の枠 

    Background → ☑を入れる

    pre-edge line → ☑を外す

    post-edge line →  ☑を外す
Normalized →  ☑を外す

• Athenaでは、右図の赤線で示される
バックグラウンド (単純な原子のX線吸収
スペクトルの近似曲線) の推定に、Autobk

というアルゴリズムを利用している。この
アルゴリズムでは、バックグラウンドを
スプライン関数で近似している。(p.3(C))

バックグラウンドの決定 (スプライン曲線とは) 25



バックグラウンド（スプライン曲線）をデータから差し引くための
Spline rangeを決定する手順は以下の通りである。

(1) Plotting k-weights（フーリエ変換の重み付け (kn χ(k)の n) ）を 3 にする
（基本は 3だが、経験的に、散乱原子が軽元素ならば 2、金属ならば 3 が目安。(※)）

(2)       を押した後、k の表示範囲を kmin 0、kmax 18 にする

(3) EXAFS振動に 試料由来のノイズがどこから含まれるか の算段を付ける (p.27)

(4) EXAFS振動に 測定由来のノイズがある場合は Spline range を狭める (p.28) 

測定由来の
ノイズ

26バックグラウンドの決定 (Spline range の決定手順)

(※) 但し、p.3(F)では「散乱原子が軽元素と重元素からなる場合、動径構造関数で、軽
元素の散乱ピークを意図的に強調したい時は n=1、逆に重元素を強調したい時は n=3 

として、各元素の寄与を相対的に大きくすることもある」という内容が書かれている。 



• CuO-EXAFS.dat の試料由来のノイズが入ってくる k の範囲の算段を
付けるために、Forward Fourier transform parameters で

arbitrary k-weight ：6

Plotting k-weights：kw

にした後、   を左クリックする

• 発散していく部分(k=13)からが、試料由来のノイズ
であると推測される (但し、重元素の測定では判断しにくいことがある。P.41) 

• p.30 のフーリエ変換時に、k=3~13を範囲の“目安”と考えると良い

Cu-foil.datを同条件で表示させたとき

27バックグラウンドの決定 ((3)試料由来のノイズ判断)

ビーム照射した
範囲内で
試料が均一だと、
高波数側で
収束する

13



• Plotting k-weights を 3 に戻して、 でグラフを表示させる

• CuO-EXAFS.dat は k=14.7 辺りに測定由来のノイズがあるため、
Spline range in k を 0 to 14.6 にする

※ 測定由来のノイズ（例：パルスノイズ、等）が見られなければ、
解析中に不具合が出ない限り、Spline range は変更しなくて良い

0~14.6

28バックグラウンドの決定 ((4)測定由来のノイズ判断)

測定由来のノイズ
（パルスノイズ）



qの EXAFS振動に対してフィッティングを行う

Artemis

AthenaでのEXAFS解析のフロー図 29

「kの範囲などの条件」を決定する

EXAFS振動の抽出 ( )

「吸収端におけるエッジジャンプ μ0(E0)」と
「バックグラウンド (スプライン曲線)」を決定する

「Rの範囲などの条件」を決定する

フーリエ変換    ( )

Athena

逆フーリエ変換   ( )



Forward Fourier transform parameters のパラメータを検討する。

• window は Hanning のまま (window とは窓関数のことである)

• dk は 1 のまま (解析者によっては 0 や 0.5 にする場合もある)

• k-range (実試料では小数点第一位まで検討) を変えた後、  を左クリック

フーリエ変換の条件決定 ( k の範囲の判断基準)

k=3~10 k=3~11 k=3~12

k=3~13 k=3~14 k=3~14.5

30

ノイズ
と判断

ノイズが
増加

分解能向上で
ピーク出現

ノイズが
更に増加

ピーク形状
が非対称

分解能悪化で
ピーク消失



k = 3~13でフーリエ変換して得られた動径構造関数 (p.18 左下) に対し、
第一配位圏 の EXAFS振動 (q空間) を表示する手順を以下に示す。

• 右下の黄色の枠の Window に☑を入れ、窓関数をグラフに表示させる

• Backward Fourier transform parameters の R-range を 1 to 2 にする
(第一配位圏の窓関数の範囲。実試料の解析では小数点第一位の値まで検討する)

• window は Hanning のまま（window = 窓関数）

• dRは 0 のまま（解析者によっては 0.1 にする場合もある）

•   を押して、逆フーリエ変換の範囲を確認する

•   を押した後、qの表示範囲を qmin 0、qmax 18 にして、第一配位圏
に対する EXAFS振動を確認する ( を押すと k と q が同時に表示される)

[prjファイルの保存]  File → Save project as… → 名前を入力(1バイト文字!) →保存

31逆フーリエ変換の条件決定、prjファイルの保存

第一配位圏



• CuO.dat と CuO-EXAFS.dat を Athena に読み込む

• 各データの E0 の小数点以下の値を消す
(この時の各データのE0は、CuO.dat 8989 eV,  CuO-EXAFS.dat 8983 eV である)

• CuO.dat と CuO-EXAFS.dat に☑を入れ、   を左クリックする

• k の表示範囲を kmin 0、kmax 18 にする (左図。異なるスペクトルにも見える)

• CuO-EXAFS.dat の E0 の値を CuO.dat にコピーする (右図。周期が揃う)

E0 を
コピー

32【参考】EXAFS解析で E0 を揃える重要性

ちなみに…

CuO.dat と CuO-EXAFS.dat のスペクトルには、ペレット作製の良し悪しが見られる
  （例：CuO-EXAFS.dat の方が振幅が小さい、ノイズが大きい、等）

  → 良好なスペクトルを得るためには、透過法では特に、試料調製が重要！



AthenaとArtemisでの

「EXAFS解析の具体例」

使用するデータ

• AuFoil.dat

• Au100.dat

• Au200.dat

• Au300.dat

• Au400.dat

33



AuPd複合ナノ粒子の説明、データ読込

• AuFoil.dat / Au100.dat / Au200.dat / Au300.dat / Au400.dat を読み込む (p.16)

  （例えば、Au100.dat は、AuPd複合ナノ粒子を100℃に昇温した試料のことを示す。）

• この後の説明は、2018年2月27日にKEKで開催された「XAFS講習会 2017」
で、仁谷先生が用いていらしたパラメータを適用します。

  （但し、「解析事例の紹介に重点を置いた内容として講習会で提示してくださった
      そうなので、設定するパラメータは参考程度に捉えてください。）

[Ref.1] 仁谷浩明、「XAFS解析演習」、https://pfxafs.kek.jp/images/mc-group/

XAFSworkshop.pdf (2019年10月15日 最終閲覧).

[Ref.2] T. Nakagawa, H. Nitani et al., Ultrason. Sonochem. 12 (2005) 249-254. 

34



• データをコピーする：
対象データを青色反転させた後、同位置で右クリック 

→ [Copy current group] を左クリック（もしくは、青色反転後に Shift + Ctrl + y ）

• データ名を変更する：データ名をダブルクリックする

• 一つのデータを消去する：
  対象データを左クリックして青色反転させた後、
  同位置で右クリック

→ [Remove current group] を左クリック

• 複数のデータを消去する：
対象データに☑を入れた後、データ名の上で

  右クリック
→ [Remove marked groups] を左クリック

• データの並び順を一つ 上 にする：Alt + k

• データの並び順を一つ 下 にする：Alt + j

(AuFoil.dat を一番上にしましょう。)

• 全てのデータに☑を入れる ：   を左クリック

• 全てのデータから☑を外す ：   を左クリック

• 選択したデータの☑を反転させる ：   を左クリック

便利機能の紹介 (1) 35



• 基準とする AuFoil.datの E0(吸収端)のエネルギーの小数点以下の値を消す

（EXAFS解析を行う場合にオススメ。Artemisのフィッティング
結果は、このE0の数値からの“相対値”で算出されるため。）

• AuFoil.dat の E0 の値を他のデータにコピーして、E0を揃える
 

➢ E0 の値を揃えたいデータに ☑を入れる
➢ コピーの元になるデータ(今回は AuFoil.dat とする)を左クリックして
青色反転させる

➢ Athena の E0にマウスを合わせて右クリックする 

➢ [Set marked this value of E0] を左クリックする

E0の小数点以下の消去、E0を揃える 36



• 右下の黄色の枠
Background → ☑を外す
pre-edge line → ☑を入れる
post-edge line →  ☑を入れる

• Normalization order → 3（2次関数）
• Pre-edge range →   -250 ~ -70 （E0からの相対値）
• Normalization range → 300 ~ 1000（同上）

• Pre-edge rangeと Normalization rangeの値を、全てのデータに
コピーする (参考p.36)

（※規格化の範囲が揃っていると、恣意性をなくすことができる）

37吸収端でのエッジジャンプ μ0(E0) の決定 



複数データを積み上げてグラフに表示

• を左クリックする
• Plotting k-weights を 3 にする
• k の表示範囲(p.14 ⑫)を kmin 0、kmax 20 にする

• [Plot in k-space] → [Stack plots] にする
• Increment に -5 (マイナス5) と入力する
（5 にすると、グラフでの並び順が逆になる）

• [Apply to marked] を左クリックする
• を左クリックする

38



便利機能の紹介(2)

グラフの「タイトル」を変更したい

➢右下のタブで [ Title, legend, single file ] を選択する
➢ Title for marked group plot の白枠にタイトルを入力する

グラフの「凡例の位置」を変更したい

➢右下のタブで [ Title, legend, single file ] を選択する
➢ Legend location で、変更したい位置の選択肢を選ぶ (例：top right)

➢凡例を枠外に表示させたい時は、Out side に ☑を入れる

を
クリック

39



• Au関係の全てのデータのスペクトルを比較したとき、測定由来の
ノイズが 最も低波数側 に現れるデータは、AuFoil.datである

• AuFoil.dat の Spline range in k を 0 to 16にする
• 他の全てのデータに、Spline range in k の値をコピーする (参考p.36)

• [Stack plots] の Increment に 0 を入力する → [Apply to marked] を
左クリックする (p.38)

• を左クリックする

EXAFS解析を行いたい全てのデータについて、
E0, Spline range, k-range, R-range の値を揃えること！

を
クリック

40バックグラウンドの決定 (測定由来のノイズ判断)



•  散乱原子が重元素(Au, Pd)であり、包絡線形状により k=15付近で
 スペクトルが一度収束するため、
試料由来のノイズの判断が今回は難しい。

• Plotting k-weights を 3 にする
• [ Title, legend, single file ] の Outside の☑を外した後 (p.39)、

[Plot in k-space] に変更する
• Forward Fourier transform parameters 

k-range：2.4 to 15.9 / dk：0.5    にする
• Forward Fourier … の値を全てのデータにコピーする (参考p.36)

41

※この後の解析手順を”各自の試料”で行う時、変換範囲によっては打ち切りノイズ
(p.42)が発生することを考慮して、その都度でスペクトルを確認しながらパラ
メータを決定すること。

バックグラウンドの決定 (試料由来のノイズ判断)



• AuFoil.datを青色反転させた後、右下の黄色の枠の
 Window に☑を入れ、窓関数をグラフに表示させる

• を左クリックする

※ k が 3以降は、XANES (NEXAFS) の
成分が含まれていないと考えてよい

※ 振幅が 節以外になっている場所で
変換すると、打ち切りノイズが
入ることがある

→ dkを 0.5~1にすることで、
打ち切りノイズを防ぐ

→ ノイズが出ないことを全データに
ついて確認しながら、低波数側は 

2.5 Å-1程度までを目安に、振幅の
節付近に値を設定することもある

42フーリエ変換の条件決定 (複数データでの判断)



• Backward Fourier transform parameters 

     R-range：1.8 to 3.3 / dR：0.1    にする

• Backward Fourier … の値を全データにコピーする (参考p.36)

• 右下の黄色の枠の Window に☑を入れ、窓関数をグラフ表示
•  を左クリックする
•  でも表示させてみる (全データに対し、R-range の値が問題ないことを確認)

※逆フーリエ変換したいピークの
 裾から裾までで、R-rangeの範囲を
 設定する

※ dRは 0 で問題ないと考えられるが、
 解析者によっては 0.1 と設定する
 こともある

43逆フーリエ変換の条件決定 (複数データでの判断)

[prjファイルの保存]  File → Save project as… → 名前を入力(1バイト文字!) →保存

第１配位圏



解析後にテキストデータとして保存

• テキストデータとして保存したいデータに☑を入れる
• File → Save marked groups as → 保存したい形式を選択

  μ(E)   ：生データ
  norm(E)：規格化した後のデータ
  k3χ(k) ：k3の重み付けした χ(k)

• データ名を入力する (1バイト文字！) 

 → 保存

グラフに積み上げて表示させたデータのままテキストデータにしたい

• 積み上げたデータをグラフに表示させる (p.38)

• 右下のタブで [Title, legend, single file] を
 選択する

• [Save next plot to a file] を左クリックする
• 保存したい表示形式（E, k, R, q）の

 ピンク色のボタンを左クリックする

• データ名を入力する (1バイト文字！) → 保存

44



Artemisの使い方

～EXAFSスペクトルの解析方法～

45



Athena/ArtemisによるEXAFS解析の流れ

• EXAFS振動の抽出のために、「吸収端におけるエッジジャンプ μ0(E0)」
と「バックグラウンド (スプライン曲線)」を決定する

• フーリエ変換 ( k → R ) のために、「kの範囲などの条件」を決定する
• 逆フーリエ変換 ( R → q ) のために、「Rの範囲などの条件」を決定する

• Athena で解析した【標準試料】のデータを読み込む
• Scattering Path (散乱経路) を求めて EXAFS振動のフィッティングを行う
ために、以下のいずれかの方法を用いる

  ① 自分で結晶構造パラメータを入力する方法
  ② CIFファイル (Crystallographic Information File) を用いる方法
  ③ QFS (Quick First Shell fit) を用いる方法（XAFSならではの方法！）
  ④ FEFFファイルを編集する方法（最もXAFSならではの方法！）

• フィッティングの変数( S0
2 / E0 / R / σ2 )と グラフ の妥当性を判断する

Artemis

Athena

• 【未知試料】のデータに対して、「標準試料で求めた S0
2」を適用しな

がら、上記の ①～④ のいずれかの方法でフィッティングを行う

• フィッティングの変数( N / E0 / R / σ2 )と グラフ の妥当性を判断する

46



Artemisでの prjファイルのデータ読込

• 【Artemis [EXAFS data analysis]】の
Data sets の [Add] を左クリックする

• prjファイルを選択する → [開く]

• 【Artemis: Import from Athena project 

file】で、AuFoil.dat を青色反転させる
• Athenaでの解析結果を継承するために、 

Take parameters from は、Project file 

に ⦿ を入れる
• [Import selected data]を左クリックする

※ Artemisで読み込めるデータは１つずつ

47



Artemisによる解析手順の基本的な考え方

第１段階： 標準試料について解析

• FEFFの理論計算から、各散乱経路に対応した F と ϕ、及び、それらに対する 

“Scattering Paths (p.54)” が得られる

•  N を固定値にしてフィッティングを行い、S0
2、R、σ2、E0を求める

第２段階： 未知試料について解析

• FEFFの理論計算から、F と ϕ、及び、それらに対する “Scattering Paths” が得られる

•  S0
2を固定値にしてフィッティングを行い、N、R、σ2、E0を求める 

FEFFによる理論計算で求まる
パラメータ 

Fi(k) ： 後方散乱因子
ϕi(k) ： 位相因子

フィッティングで求めるパラメータ

S0
2 ： 多体効果による減衰因子

Ni ： 配位数（標準試料では既存値）
ri ： 原子間距離、配位距離
σi ： デバイワラー因子
E0 ： 吸収端 (kの原点)

48



Artemisによるフィッティング方法

① 自分で結晶構造のパラメータを入力する方法

  ・試料の結晶構造のパラメータ (空間群、格子定数、等) が既知の場合に適する

② CIFファイル (Crystallographic Information File) を用いる方法

  ・XRD等で得た 試料のCIFファイル を持っている場合に適する

・標準試料 (Auバルク等) の CIFファイルは、以下のWebサイトにアップロード
されている可能性がある（本資料の pp.87~93 で紹介）

③ QFS (Quick First Shell fit) を用いる方法
④ FEFFファイルを編集する方法

  ・③④は XAFSならではの解析手法！ 構造情報がなくても解析可能。

  ・吸収原子、散乱原子、大体の原子間距離 を仮定して解析する

  ・第２配位圏以降は、第１配位圏の原子による前方散乱等の影響を無視できない
  可能性があるので注意する（それを理解した上でフィッティングを行う）

49

The Materials Project

  【管理団体】Lawrence Berkeley National Laboratory (“LBNL”, or “Berkeley Lab”)



① 結晶構造のパラメータを入力する方法 (1)

• 【Artemis [EXAFS data analysis]】の Data sets の [Add] を左クリック
して、prjファイル内の  AuFoil.dat を読み込む (p.47)

• Feff calculations の [Add] を右クリックする

• 【Recent Feff or crystal data file】の  [-----] Open a blank Atom window 

を青色反転させて、[OK] を左クリックする

50



① 結晶構造のパラメータを入力する方法 (2)

• 【Artemis [Feff] Atoms and Feff】の   にパラメータを入力する
Name → Au

Space Group → 225 または fm3m (それぞれ、空間群での fcc構造 の表記)

Edge → L3

Lattice constants → A=4.08、α=90

Core に☑を入れる
El. → Au

(x, y, z) → (0, 0, 0)

• Run Atoms (         )を
 左クリックして、
 FEFFファイルを作成する (p.52)

•  のタブで

 Run Feff (         )を左クリック

 して、FEFFの理論計算を行う
(p.53)

51



•  吸収原子、吸収端、結晶構造パラメータを入力または選択した後、

Run Atoms ( ) を左クリックすることで、FEFFで理論計算

するための入力形式のファイル (FEFFファイル) を作成できる。

52

吸収端

吸収原子

Feff6 - elem

の形式で出力

空間群
格子定数

半径距離

・結晶構造の
クラスタ
サイズ

・FEFF計算の
最大Path

① 結晶構造のパラメータを入力する方法 (3)

原子位置



53

• FEFFファイル (Feff input file) が表示される。

•  Run Feff (          ) を左クリックすると、FEFFの理論計算により求まった 

F と ϕ に対する “Scattering Paths (p.54)” が得られる。

feff6 fileが作成された。

各行の＊より右側にある文字列はコメント
であり、FEFFの理論計算では無視される。

HOLEは、吸収端の種類 (K, L1, L2, L3) を
それぞれ (1, 2, 3, 4) で表している。

POTENTIALS

・ipot 0⇒吸収原子 / ipot 1⇒散乱原子

・Zは 原子番号

※ 必要に応じて、FEFFファイル (Feff input file)の内容を編集すること！

  (具体例は、p.69 や p.76 を参照）

ATOMS

・(x, y, z) は 実距離で表した各軸の原子位置

・distance は (0, 0, 0) からの直線距離

① 結晶構造のパラメータを入力する方法 (4)



解析で用いる Scattering Path を決定するために、グラフへ表示させる。

•   のタブで、Shiftキーを押しながら全ての ”Scattering Paths” を選択
する（特定のPath のみを表示させたい時は Ctrlキーを押しながら選択する）

•    を左クリックした後、  を左クリックする

（※フィッティングは基本的に single scatteringのみを考える。4 Åより遠いピークは、
複数の隣接原子に散乱された多重散乱の Pathの寄与が無視できなくなってくる。）

54① 結晶構造のパラメータを入力する方法 (5)

各項の意味 https://www.apch.kindai.ac.jp/laboratory/asakura/personal/ja/others/dtj/artemis.html#path

多重散乱のPath
p.3(C)内のページ



• 第１配位圏 に対してフィッティングを行うために、Scattering 

Paths の 1 のみを左クリックして青色反転させた後、【Artemis 

[Data] AuFoil.dat】の Path listにドラッグする

Path list

55

ドラッグ

① 結晶構造のパラメータを入力する方法 (6)



• 【Artemis [EXAFS data analysis]】の   を左クリックする

• 【Artemis [Data] AuFoil.dat】で、[Path] → [Quick 4 parameter fit] を
左クリックし、S02 / ΔE0 / ΔR / σ2  の 4つの変数を自動で入力する(※)

フィッティングの初期値(※)

を確認する

GDSは Type の種類の頭文字
G : guess (推測する)

D : define (定義する)

S : set (設定する)

56① 結晶構造のパラメータを入力する方法 (7)

S02  : 多体効果による
  減衰因子

ΔE0 : Athenaで設定
 したE0の値
 (p.13 ② の左上)

からの差
ΔR : 原子間距離の

 初期値Reffからの差
 σ2 : デバイワラー因子

(※) 変数は他の文字列でもよい。変数やフィッティングの初期値は各欄に手入力可能。



• k3χ(k)のデータに対してフィッティングを行うために、
【Artemis [Data] AuFoil.dat】の Fitting k weights において、3 のみ
に☑を入れる（ k3χ(k)を選んだ理由は、p.26 (1) を参照）

• q 空間のスペクトルに対してフィッティングを行うために、
【Artemis [EXAFS data analysis]】の Fit space で q に ⦿ を入れた後、
[Fit] を左クリックする

57

フーリエ変換・
逆フーリエ変換の
パラメータ
(Athena で決定済)

① 結晶構造のパラメータを入力する方法 (8)



最大で使用できる変数の数 NVは、
Δk：フーリエ変換の範囲
Δr：逆フーリエ変換の範囲
とすると、

で表される。(今回は NV ≈12.9)

フィッティング結果の妥当性の判断 (1) (数値)

• 【Artemis [Log] Fit1】にフィッティング結果が出る (前半部の説明)

今回のフィッティングでの変数の数

𝑁𝑉 =
2∆𝑘 ∙ ∆𝑟

𝜋

R-factor は、～0.05 が目安

フィッティングで得られた各変数の値
と標準偏差、及び、[初期値] (p.56下)

各変数の相関関係

• 帯の色は参考程度と捉えること

• 必ず自分でフィッティング結果の
数値やグラフを確認して、妥当性
を判断すること (pp.58~61)
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フィッティングに使用した
各パラメータ

各k-weight における R-factor

• 【Artemis [Log] Fit1】にフィッティング結果が出る (後半部の説明)

59フィッティング結果の妥当性の判断 (2) (数値)

フィッティングで求めた数値の見方

• 吸収端 (eV)：
E0(11910) + e0(4.280) ≈ 11914.3

• 原子間距離 (Å)：
Reff(2.885) + delr(-0.0296) ≈ R(2.855)

フィッティング結果の目安

• 多体効果による減衰因子 S02：
0.8~0.9程度

• デバイワラー因子 sigma^2 (σ2)：
0.01未満（つまり、σ は 0.1未満）



フィッティングの良し悪しをグラフ上で確認するときに注目すべき
「表示形式」とその操作方法について、(1) と (2) に述べる。

(1) q 空間を Real (実部) で表示させたとき、フィッティングが
  合っているか

• 【Artemis [Plot]】で、k-weight の 3に ⦿ を入れる

• 表示範囲を qmin 0、qmax 20 にする

• limits のタブの Plot χ(q)の Real に ⦿ を入れ、   を左クリックして
グラフに表示させる

で

をクリック

60フィッティング結果の妥当性の判断 (3) (グラフ)



(2) R 空間で Real (実部) と Imag.(虚部) でそれぞれ表示させたとき、
  フィッティングが合っているか

• 【Artemis [Plot]】で k-weight の 3に
⦿ を入れる

• limits のタブの Plot χ(R)の Realに ⦿ を
入れ、 を左クリックして

 グラフに表示させる

• limits のタブの Plot χ(R) で Imag. に 

⦿ を入れ、 を左クリックして
 グラフに表示させる

で

をクリック

絶対値
実部
虚部

図 3.1.4 Cu箔のフーリエ変換後のスペクトル.

日本XAFS研究会編「XAFSの基礎と応用」より

61フィッティング結果の妥当性の判断 (4) (グラフ)



② CIFファイルを用いる方法 

• 【Artemis [EXAFS data analysis]】の
Feff calculations の [Add] を左クリック
する

• CIFファイルを選択する → [開く]

• 【Artemis [Feff] Atoms and Feff】の
のタブで、パラメータを確認

する（特に、Edgeに注意）

• Run Atoms (          )を左クリックする

•  のタブで、Run Feff (         )を
左クリックする

※この後のフィッティングの手順は ①と同じ
である (pp.54~61)
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③ QFS (Quick First Shell fit) を用いる方法 (1)

• 【Artemis [EXAFS data analysis]】の Data sets の [Add] を左クリック
して、prjファイル内の AuFoil.datを読み込む (p.47)

• 【Artemis [Data] AuFoil.dat】の Start a quick first shell fitを
左クリックする
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• 【Artemis: Set up a quick first sh…】に以下のパラメータを入力する
Absorber (吸収原子)   → Au

Scatterer (散乱原子) →  Au

Edge (吸収端の種類) →  L3

Distance (原子間距離) → 2.885

• [OK] を押す

• 【Artemis [Data] AuFoil.dat】に、「Scattering Path (散乱経路)」と
「フィッティングの変数」が自動で入力される

64③ QFS (Quick First Shell fit) を用いる方法 (2)



65③ QFS (Quick First Shell fit) を用いる方法 (3)

• k3χ(k)のデータに対してフィッティングを行うために、
【Artemis [Data] AuFoil.dat】の Fitting k weights において、3 のみ
に☑を入れる（ k3χ(k)を選んだ理由は、p.26 (1) を参照）

• q 空間のスペクトルに対してフィッティングを行うために、
【Artemis [EXAFS data analysis]】の Fit space で q に ⦿ を入れた後、
[Fit] を左クリックする

フーリエ変換・
逆フーリエ変換の
パラメータ
(Athena で決定済)



①と③で得たフィッティング結果の比較

① 結晶
(手入力)

③ QFS
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下式のように S0
2 と N は掛け算で表されるため、③QFS の S02の値 をAuバ

ルクの配位数12で割ると、①結晶(手入力) の S02の値 とほぼ同じになる。

⇒ Artemis で N の欄に入力できる値は整数のみのため、未知試料の配位数を
 求めたい場合は、N=1 とし、かつ、S02 の欄に N の変数も含める。(p.74)

上式における各パラメータの意味は、p.48参照。

掛け算で表される



④ FEFFファイルを編集する方法 (1)

• 【Artemis [EXAFS data analysis]】の Data sets の [Add] を左クリック
して、prjファイル内の  AuFoil.dat を読み込む (p.47)

• Feff calculations の [Add] を右クリックする

• 【Recent Feff or crystal data file】の  [-----] Open a blank Atom window 

を青色反転させて、[OK] を左クリックする

67



④ FEFFファイルを編集する方法 (2)

• FEFFファイルのひな型を作るために、【Artemis [Feff] Atoms and Feff】
の   に以下のパラメータを入力する

Name → Au

Space Group → 1 または P1 (対称性なしの空間群)

Edge → L3

Lattice constants → A=2.885、α=90 (例として、Au-Au の原子間距離を入力)

Core に☑を入れる
El. → Au

(x, y, z) → (0, 0, 0)

• Run Atoms (         )を
左クリックして、
FEFFファイルを
作成する

68

※ Atomsタブ (            ) を用いると、FEFFファイルのひな型を作成できる。

  必要箇所だけを編集すれば良いので便利である。

2.885 Å



• 「吸収原子(Au)から 2.885 Åの距離の位置に、散乱原子(Au)が１つだけ
存在する」

という状態を作成するために、 のタブの Feff input file の ATOMS

を以下のように編集する

  (編集後は、p.64 の QFS の【Artemis: Set up a quick first sh…】と同じ内容を表す)
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• Run Feff (         )を左クリックして、FEFFの理論計算を行う

編
集
前

編
集
後

ipot 0 (吸収原子)

x = 0

y = 0

z = 0

ipot 1 (散乱原子)

x = 2.885

y = 0

z = 0

END

④ FEFFファイルを編集する方法 (3)

※この後のフィッティングの手順は ①と同じである (pp.54~61)。
 但し、散乱原子は１つだけなので、N=12 ではなく N=1 となっている。



• Athena で解析した【標準試料】のデータを読み込む
• Scattering Path (散乱経路) を求めて EXAFS振動のフィッティングを行う
ために、以下のいずれかの方法を用いる

  ① 自分で結晶構造パラメータを入力する方法
  ② CIFファイル (Crystallographic Information File) を用いる方法
  ③ QFS (Quick First Shell fit) を用いる方法（XAFSならではの方法！）
  ④ FEFFファイルを編集する方法（最もXAFSならではの方法！）

• フィッティングの変数( S0
2 / E0 / R / σ2 )と グラフ の妥当性を判断する

Athena/ArtemisによるEXAFS解析の流れ

• EXAFS振動の抽出のために、「吸収端におけるエッジジャンプ μ0(E0)」
と「バックグラウンド (スプライン曲線)」を決定する

• フーリエ変換 ( k → R ) のために、「kの範囲などの条件」を決定する
• 逆フーリエ変換 ( R → q ) のために、「Rの範囲などの条件」を決定する

Artemis

Athena

• 【未知試料】のデータに対して、「標準試料で求めた S0
2」を適用しな

がら、上記の ①～④ のいずれかの方法でフィッティングを行う

• フィッティングの変数( N / E0 / R / σ2 )と グラフ の妥当性を判断する
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AuPd複合ナノ粒子のEXAFS解析の考え方

• AuPd複合ナノ粒子の Au側(Au L3-edge EXAFS)からの解析 を行う

• 考えられる結合種は Au-Au と Au-Pdなので、２シェルフィット (２つ
の “Scattering Paths (p.54)” を用いたフィッティング) を行う

• 下図のとおり400℃の方が Au-Pd結合の数が多くフィッティングが収束
しやすいため、Au400.datから解析する

[Ref.1] 仁谷浩明、「XAFS解析演習」、https://pfxafs.kek.jp/images/mc-group/

XAFSworkshop.pdf (2019年10月15日 最終閲覧).

[Ref.2] T. Nakagawa, H. Nitani et al., Ultrason. Sonochem. 12 (2005) 249-254. 
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データ読込、a blank Atoms windowを開く

• 【Artemis [EXAFS data analysis]】の Data sets の [Add] を左クリック
して、prjファイル内の  Au400.dat  を読み込む (p.47)

• Feff calculations の [Add] を右クリックする

• 【Recent Feff or crystal data file】の [-----] Open a blank Atom window 

を青色反転させて、[OK] を左クリックする
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Au-Au の Path の作成 (1) (FEFFファイルの作成)

• 【Artemis [Feff] Atoms and Feff】の  にパラメータを入力する
Name → Au-Au

Space Group → 225 または fm3m (それぞれ、空間群での fcc構造 の表記)

Edge → L3

Lattice constants → A=4.08、α=90

Core に☑を入れる
El. → Au

(x, y, z) → (0, 0, 0)

• Run Atoms (         )を
左クリックして、
FEFFファイルを作成する

•  のタブで、
 Run Feff (         )を左クリックして、FEFFの理論計算を行う

• Au-Auの Feff calculations と分かるように名前を変更する (図は p.76)：
【Artemis [EXAFS data analysis]】Feff calculations で、[Hide ”new”] を
右クリック → Rename this Feff object →「Au-Au」→ [OK]
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• 【Artemis [Feff] Atoms and Feff】の    で、Scattering Paths の
1を【Artemis [Data] Au400.dat】の Path list にドラッグする (p.55)

• 【Artemis [Data] Au400.dat】のタブの [Path] → [Quick 4 parameter fit] 

を左クリックして変数を自動入力 (p.56)

• 以下のように入力 (S02 に N の変数も含める p.66)

N = 1（N には整数のみ入力可）

S02 = amp*nau（nau は配位数の変数）

• 【Artemis [EXAFS data analysis]】の
 を左クリックする

• 以下のように入力する (p.56 GDSの意味)

   set で、amp = 0.9 (※)

   guess で、nau = 6（fccの配位数の半分）

(※) 標準試料で求めた S02 の値を固定値として
入力することが一般的である。標準試料が無い場合は、経験的に 0.9 と設定しても
良い。但し、これらS02の値の差異は、配位数 (nau) に影響を与える。(参考 p.66)

74Au-Au の Path の作成 (2) (パラメータの設定)



• 【Artemis [EXAFS data analysis]】の Feff calculations の [Add] を
右クリックする (p.72)

• 【Recent Feff or crystal data file】の [-----] Open a blank Atom window 

を青色反転させて、[OK] を左クリックする (p.72)

• 【Artemis [Feff] Atoms and Feff】の  にパラメータを入力する
Name → Au-Pd

Space Group → 225 または fm3m (それぞれ、空間群での fcc構造 の表記)

Edge → L3

Lattice constants → A=4.08、α=90

Core に☑を入れる
El. → Au

(x, y, z) → (0, 0, 0)

• Run Atoms (          )を
左クリックして、
FEFFファイルを作成する

Au-Pd の Path の作成 (1) (FEFFファイルの作成) 75



• 「吸収原子の Au原子 の周りに、散乱原子の Pd原子 が存在する」
という構造を作成するために、【Artemis [Feff] Atoms and Feff】の
  の Feff input file の POTENTIALSで、ipotの 1 を次のように
 書き換える

• Run Feff (         )を左クリックして、FEFFの理論計算を行う

• Au-Pdの Feff calculations と分かるように名前を変更する：
【Artemis [EXAFS data analysis]】Feff calculations で、[Hide ”new”] 

を右クリック → Rename this Feff object →「Au-Pd」→ [OK]

Z    → 46

tag → Pd

76Au-Pd の Path の作成 (2) (FEFFファイルの編集)



• 「Au-Pd」に対する【Artemis [Feff] Atoms and Feff】の   で、
Scattering Paths の 1を、【Artemis [Data] Au400.dat】の Path listに
ドラッグする (p.55)

• 【Artemis [Data] Au400.dat】のタブの [Path] → [Quick 4 parameter 

fit] を左クリックして、変数を自動入力する (p.56)

  (※但し、表示されている Path list の全ての変数が再入力されるので、
            Path listの [Au-Au] Au.1の S02 に nauを入力し直す必要がある。(p.74))

• Path listの [Au-Au]の変数（amp, enot, delr, ss）と区別するために、
各変数の末尾に 2を付ける

• 以下のように入力 (S02 に N の変数も含める p.66)

N = 1（N には整数のみ入力可）

S02 = amp2*npd（npd は配位数の変数）

77Au-Pd の Path の作成 (3) (パラメータの設定)

Path list



• 【Artemis [EXAFS data analysis]】の   を左クリックする

• 赤色(エラー)になっている部分の Type, Name, Math expressionを、
以下のように変更する (p.56 GDSの意味)

• 配位数の変数として、npdを追記する

def amp2 = amp （変数の数を減らすため）

guess  enot2 =0     （Path list で入力したように末尾に 2を付ける）

guess  delr2 =0        （同上）

guess  ss2 =0.003    （同上）

guess  npd = 6 （配位数の変数。6 は fcc構造の配位数の半分の値）

78Au-Pd の Path の作成 (4) (GDSの変更)



Au400.dat のフィッティング

• 【Artemis [Data] Au400.dat】の Path list の [Au-Au]と [Au-Pd]につい
て、 k3χ(k)に対するフィッティングを行うために、Fitting k weights の 

3 のみ に☑を入れる
（ k3χ(k)を選んだ理由は、p.26 (1) を参照）

• q 空間のスペクトルについてフィッティングを行うために、【Artemis 

[EXAFS data analysis]】の Fit space の 

q に⦿ を入れ、[Fit] を左クリックする

• フィッティング結果の数値を確認する (pp.58~59)

• 【Artemis [Plot]】の k-weight を 3 にする

• 表示範囲を qmin 0、qmax 20 にする

• フィッティング結果のグラフを   や
   で表示させて確認する (pp.60~61)  

79

の場合



Au300.datのフィッティング

Au400.dat のフィッティング結果の値を初期値にして、Au300.datの
スペクトルをフィッティングする。

• 【Artemis [EXAFS data analysis]】の を左クリックする

• 【Artemis [GDS] Guess, Def, Set parameters】の右上の   を
左クリックする (Au400.dat のフィッティング結果が各変数の初期値になる)

• 【Artemis [Data] Au400.dat】の 

[Data] → [Replace this χ(k)] を左クリックする

• 対象の prjファイルを開く

• Au300.datを青色反転させ、[Import selected 

data] を左クリックする

• 【Artemis [EXAFS data analysis]】の Fit space の q に ⦿ を入れ、
[Fit] を左クリックする

• Au200.dat は Au300.dat のフィッティング結果の値、
Au100.dat は Au200.dat のフィッティング結果の値、
を初期値に用いて、同様にフィッティングを行うと良い
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[参考] フィッティングの結果 (Au400, Au300)

[Fit]

[Fit]
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[Fit]

[Fit]

[参考] フィッティングの結果 (Au200, Au100) 82



[Ref.1] 仁谷浩明、「XAFS解析演習」、https://pfxafs.kek.jp/images/mc-group/

XAFSworkshop.pdf (2019年10月15日 最終閲覧).

pp.81~82 で示した nauや npd は
下記の値と異なります！
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• 【Artemis [Data] AuFoil.dat】の Path listの中で、消去したいデータ
を左クリックして青色反転させる

• 【Artemis [Data] AuFoil.dat】のタブの [Path] → [Discard displayed 

path] を左クリックする

84Path list のデータを消去 (例: AuFoil.dat)

Path list



• 合成したい Path を【Artemis [Data] AuFoil.dat】にドラッグする (p.55)

• 【Artemis [Data] AuFoil.dat】の Path listで、合成したい Path に☑を入れる

• [Action] → [Make sum of marked paths and plot in R] を左クリックする

85Scattering Paths のデータの合成 (例: AuFoil.dat)

このグラフで言うと
緑線がデータを足し
合わせたものである

Path list

(注) 各Path は S0^2 =1、σ=0（つまり、全く減衰がないもの）としているため、
実測のEXAFSスペクトルとは異なる。

• 【Enter a VPath name】に名前を入れて、[OK]を押す



【Artemis [Plot]】の を押しても、
スペクトルをグラフに表示できない場合の対応方法を以下に示す。

• 【Artemis [Plot]】(縦長の表示画面)の limitsのタブの Plotting listに、
グラフへ表示させたいデータがあるかどうかを確認する

• データが無かったときは、【Artemis [Data] AuFoil.dat】のうち、
グラフに表示させたいデータ（例:    や ）
の を押す

• 【Artemis [Plot]】の limits のタブの Plotting list で、グラフへ表示
させたいデータに☑を入れる

• 【Artemis [Plot]】の limits のタブの Plot χ(R)や Plot χ(q)で、
表示させたい形式に ⦿ を入れたのち、   を
それぞれ押す

86グラフに表示できない場合の対応 (例: AuFoil.dat)



The Materials Project の紹介

87

p.49 ② CIFファイル (Crystallographic Information File) を用いる方法 で
紹介したWebサイトの使い方



Sign in の方法 88

•  https://next-gen.materialsproject.org/ にアクセス (2023年10月17日最終閲覧)

• Login or Register (  ) または Loginを左クリックする

The Materials Project

【管理団体】Lawrence Berkeley National Laboratory (“LBNL”, or “Berkeley Lab”)

• 以下のいずれかのアカウントを用いて、Sign in する

Github / Google / Facebook / Microsoft / Amazon / e-mail アドレス

Login後は、この部分が
Start Exploring Materials

(  )

の表示になる。



CIFファイルの保存方法(1) 89

例として、AuバルクのCIFファイルを得る方法を紹介する。

• Start Exploring Materials ( ) を左クリックする (図は p.88) 

• Materials (  ) の空欄に対象元素（Au）を入力する、もしくは、

 周期表の対象元素（  ）を左クリックする

• Search (  )を左クリックする



CIFファイルの保存方法(2) 90

• Formula の縦列を見て、CIFファイルを得たい物質（Au）を左クリックする
（Auバルクの Space Group Symbol は Fm-3m なので、一番上を IDを選択）

•  を左クリックした後、「CIF (Symmetrized)」「CIF」のいずれかを左ク
リックして、データを保存する



XAFSスペクトルの表示方法(1) 91

The Materials Project 内の物質について、理論計算で求められたXAFS

スペクトルを参照できる場合がある。
例として、Cu と O を含む物質の Cu K-edge XANESスペクトルを表示
させる方法を説明する。(図は p.92参照)

•   (p.88)を左クリックした後、左列の  を左クリックする

• Spectra (  ) の空欄に、Cu, Oと入力する

• Edge は [K-edge]、Spectrum Typeは [XANES]を選択する

• Absorbing Element は [Cu]を入力する

• Search (  ) を左クリックする

• XANESスペクトルを表示させたい物質名の一番左の を左クリックして
を入れる

• 選択した物質のXANESスペクトルが表示される



XAFSスペクトルの表示方法(2) 92



引用論文 93

The Materials Project のサイト や 各アプリ ( など) に関する引用論文は、
以下の方法で参照できる。

• https://next-gen.materialsproject.org/ にアクセス (2023年10月17日最終閲覧)

• About ▼ → How to Cite を左クリックする



Hephaestus(ヘパイストス) の紹介

94



対象元素の吸収端や蛍光X線のエネルギー検索

吸収端 蛍光X線

元素を選択

95



エネルギー
を入力して
[Search]を
押す

入力したエネルギーに近い吸収端エネルギーが灰色で色付けされる

96任意のエネルギーにおける元素と吸収端の検索



エネルギー
を入力して
[Search]を
押す

入力したエネルギーに近い蛍光X線のエネルギーが灰色で色付けされる

蛍光X線分析(XRF)のスペクトルに現れた未知の蛍光X線の検索にオススメ

97未知の蛍光X線エネルギーに対する元素の検索
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99改訂履歴

2019/03/29 初版 本稿作成。

2023/10/17 第2版 参考資料のURLを更新。FEFFファイルの編集方法、FEFFファイ
ルの見方を追加。フーリエ変換時の重み付け k-weight の目安
の説明を追加。The Materials Project の使い方を追加。
Demeter のダウンロード方法を追加。各スライドの説明文を
一部追記・修正。便利機能の説明内容を追加。
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